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StreetMap tutorial

IN THIS CHAPTER

e Exercise 1: Getting started with
StreetMap

e Exercise 2: Exporting StreetMap
data

e Exercise 3: Geocoding on an
ArcSDE server

This tutorial introduces you to the ESRI® StreetMap™ USA extension to
ArcGIS™ [t will introduce you to the basic techniques for viewing
StreetMap data and using the StreetMap geocoding service. Exercise 2
shows how you can convert the compressed StreetMap data to a shapefile
or geodatabase feature class. Exercise 3 will show you how to create a
geocoding service in an ArcSDE™ geodatabase.

This tutorial assumes that you are already familiar with using ArcCatalog™
and ArcMap™. You should know how to copy data to a new location and
add data to a map. If you’re not familiar with geocoding, first complete the
Geocoding tutorial. If you're new to GIS or feel you need to refresh your
knowledge, please take some time to read Getting Started with ArcGIS.
You might also work through the quick-start tutorials in Using ArcCatalog
and Using ArcMap.



Exercise 1: Getting started with StreetMap

Before you begin, make sure that you have obtained a
license to use the StreetMap USA extension. Then the
StreetMap USA extension and tutorial data have been
installed on your computer. Copy the ArcTutor\Streetmap
folder, which contains data required for this tutorial, to a
new location on your computer such as the C:\ disk; you’ll
find it on your computer where the tutorial data was
installed—for example, at C:\ArcGIS. Put the Data &
Maps for StreetMap CD-ROM in your computer or find
out where the data from this CD-ROM is located on the
network.

Loading the StreetMap USA extension

The StreetMap USA extension is an “auto-enabling”
extension. This means that you do not need to explicitly
enable the extension in order to use it. When you access
StreetMap USA data in ArcGIS, a license will be checked
out for you, if one is available, and the extension will be
enabled.

1. Start ArcCatalog.
2. Click the Tools menu and click Extensions.

3. Check to ensure that StrectMap USA appears in the list
of available extensions, then click Close.

If StreetMap USA doesn’t appear in the list, the
extension hasn’t been installed. Stop ArcCatalog,
consult the installation guide, install the extension, then
start this tutorial again.

4. Add a folder connection that accesses your copy of the
StreetMap folder.

5. Add a folder connection that accesses the Data &
Maps for StreetMap CD-ROM. For example, if the CD
drive was the E:\ disk on your computer, you would add
a connection to that location.

6. Click the Launch ArcMap button on the Standard
toolbar in ArcCatalog.
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I
Launch ArcMap

7. Click OK to start using ArcMap with a new, empty
map.

8. In ArcMap, click the Tools menu and click Extensions.

9. Check to ensure that StreetMap USA appears in the list
of available extensions, then click Close.

10. Click the File menu and click Exit.

The next time you access the StreetMap USA data in
ArcGIS, a license will automatically be checked out for you,
and the extension will be enabled.

Opening the map for this tutorial

1. Select the folder connection that accesses the Data &
Maps for StreetMap CD-ROM in the Catalog tree, then
click the Contents tab in the ArcCatalog window.

The CD contains a map document, a map template, a
group layer, a geocoding service, and a folder named
“Data”. The map document and map template both
include a copy of the group layer. The StreetMap
extension must be enabled before you can access the
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StreetMap data on this CD and before you can use the
geocoding service.
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2. Double-click the StreetMap USA map document.

The map opens in ArcMap. You can use the map
template or group layer to create your own map at a
later time.
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The map contains a group layer named StreetMap USA.
This layer provides different levels of detail at different map
scales. Each of the National, State, Regional, and Local
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group layers appear when the map’s scale falls within the
appropriate range for that layer. For example, the Local
group layer appears on the map when the map’s scale is
larger than 1:200,000.
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Try zooming in and out or setting the map to different
scales. Click the plus sign next to a group layer to see the
individual layers it contains. Layers that aren’t currently
drawn on the map have gray check boxes. Look at a
layer’s properties to see the map scale at which it appears
and the data that it references. If you zoom to an area with
a map scale of 1:20,000 or larger, the detail streets are
drawn in think double lines. To make the lines joined
together, turn on the advanced drawing options. Right-click
on Layers in the map’s table of contents, then click
Advance Drawing Options in the context menu. Check the
box next to Draw using advanced drawing options in the
Advanced Drawing Options dialog. Click Apply and OK.



The National, State, Regional, and Local layers each
reference increasingly detailed data.
Finding an address interactively

You can use the StreetMap USA geocoding service to
locate addresses with the StreetMap data.

1. Click the Find button on the Tools toolbar in ArcMap.
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2. Inthe Find dialog box, click the Addresses tab.
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The StreetMap USA geocoding service is available to
you. This geocoding service resides on the Data &
Maps for StreetMap CD-ROM.

3. Type a valid U.S. street or intersection address
containing the street, city, state abbreviation, and a 5-
digit ZIP Code.

4. Click Find.

The candidates appear in the list below the Find dialog
box.

5. Right-click the top candidate in the list and click Add as

Graphic(s) to Map.

A graphic point representing the address’s location
appears on the map. Your map’s scale will remain the
same. If a large area is displayed on the map, right-click
the top candidate again and click Zoom to Candidate(s)
and Flash. The map will zoom to the Local level; this
gives you a better look at where the address is located.

6. Click Cancel.

Geocoding addresses in a table

If you have a table that contains address information, you
can geocode all of its addresses at once.

1. In ArcCatalog, click the folder connection that accesses
your copy of the tutorial StreetMap folder in the Catalog
tree.
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2. Inthe Contents tab, right-click the addr us dBASE®
table and click Geocode Addresses.

The Select Geocoding Service dialog box appears. It
lists the geocoding services that are available in your
local Geocoding Services folder.

Select Geocoding Service EHE

Select the geocoding service to use:

H

yurLogin.AtIanta_.-’-‘«ItName

— Description
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Browese for service... | [1]:% I Caticel

Click Browse for service.
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4. In the Choose a geocoding service dialog box, navigate
to the Data & Maps for StreetMap CD-ROM, click the
StreetMap USA geocoding service, then click Choose.

5. In the Geocode Addresses: StreetMap USA dialog box,
click the Browse button to define the Output shapefile
or feature class.
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Geocode Addresses: StieetMap USA EHE
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6. Inthe Saving Data dialog box, navigate to your copy of
the StreetMap folder. In the Name text box, type

“US_Result”. Click Save.

A new point shapefile named US_Result will be created
in the StreetMap folder. The point features generated by
the geocoding process will be saved in that shapefile. If
you prefer, the geocoding results can be saved in a new

geodatabase feature class.

7. Click OK to geocode the table of addresses.



When the table finishes geocoding, the Review/Rematch
Addresses dialog will appear. You can rematch the
resulting features later if you wish.

8. Click Done.

The new US_Result shapefile appears in your copy of

the StreetMap folder.
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Exercise 2: Exporting StreetMap data

While you can use the street data directly from the CD, you
may prefer to convert some of the compressed street data
to a local shapefile or geodatabase feature class on your
computer. You can export the StreetMap data using either
ArcMap or ArcCatalog.

Converting compressed street data using ArcMap

1. In ArcMap, zoom to a local area on the map or set the
map’s scale to 50,000 or larger with the scale box on the
Standard toolbar.

2. Right-click the Local Streets (Local) layer in the map’s
table of contents, point to Data, then click Export Data.
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The Export Data dialog box appears.
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3. Click the Export dropdown arrow, then click All features
In View Extent.

Export Data EE3

Expart: I.&II features In Wiew Extent j

¥ Usze the zame Coordinate System as this layer's source data.

"~ Usze the same Coordinate System as the data frame.

Output shapefile or feature class:

C:h\Streethd aphexported_streets. zhp

=
Cancel |

If you chose to export All features instead, all street
features in the United States would be exported.

4. Click the Browse button to define the Output shapefile
or feature class. Navigate to your copy of the
StreetMap folder. In the Name text box, type a name
such as “exported_streets” for the new shapefile that
will be created. Click Save.

If you prefer, the exported data can be saved to a new
geodatabase feature class. If the exported data will be
saved to disk, make sure there is enough space available
to store the results. For example, if the map scale is
1:50,000 or larger, 5 to 10 MB of space should be
sufficient.

5. Click OK to export the data.

Be aware that if you are not viewing the contents of the
Local group layer, the streets in the Local Streets (Local)
layer won’t appear on the map. However, all features



associated with this layer that fall within the view’s extent
will be exported even if they don’t appear on the map.

When a very large number of features are exported, it will
require a long period of time to convert the data, and
unexpected system errors may occur due to insufficient
disk space. If this happens, click Cancel in the Export
Progress dialog box to halt the process.

Converting compressed street data using
ArcCatalog

With ArcCatalog you can export street data either state by
state or for the entire United States at once.

1. In ArcCatalog, click the folder connection that accesses
the Data & Maps for StreetMap CD-ROM in the
Catalog tree.

2. Inthe Contents tab, double-click the Data folder, then
double-click the streets folder.

The compressed street data files are listed in the
Contents tab. There is one file for each state and the
District of Columbia and another file that contains
streets for the entire country. The name of each file is
named using the abbreviation for the state. If you aren’t
using the option to hide file extensions in ArcCatalog,
you’ll see that these files use the file extension .edg; for
example, the file “ak.edg™ contains the compressed
street data for the State of Alaska.

Right-click the dc StreetMap feature class in the
Contents tab, point to Export, then click StreetMap to
Shapefile.
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The StreetMap to Shapefile data conversion tool
appears.

Click the Browse button to define the Output shapefile.
Navigate to your copy of the StreetMap folder. In the
Name text box, type a name such as “DC_streets™ for
the new shapefile that will be created. Click Save.

* StreetM ap to Shapefile

Enter the feature clazs or feature datazet to conwvert: oK

IE Datahstrests\de.edg

Cancel

. Hel
Dutput shapefile: &

IC: “StreetbdaphDC_streets.shp

1

Batch «

Use the StreetMap to Geodatabase conversion tool
instead if you prefer to export the data to a geodatabase
feature class. Define the name of the feature class and
the feature dataset it should reside in, if appropriate.
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5. Click OK to export the data.

If you look in your copy of the StreetMap folder, you’ll
see that the new DC_streets shapefile appears in the
Contents tab.

JLocation: IE:\StreetMap j |
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If the exported data will be saved to disk, make sure
there is enough space available to store the results.
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Exercise 3: Geocoding on an ArcSDE server

If ArcInfo™ or ArcEditor™ is installed on your computer,
and if you have access to an ArcSDE geodatabase, you can
complete this exercise. ArcView® users will not be able to
complete this exercise.

Make sure the spatial database administrator has installed
and set up the StreetMap extension to the ArcSDE server.
The data from the Data & Maps for StreetMap CD-ROM
should be accessible from the server. To accomplish this,
the administrator should create an environment variable
named ESRI_US STREETS DIR in the /etc/dbinit.sde file
under the database installation folder. This variable must
contain the path to the directory that contains the US
Streets data—for example, ESRI_ US STREETS DIR=/
streetmap/data/streets. Consult the ArcSDE install guide for
more details.

Once it has been set up correctly, you will be able to create
geocoding services in your spatial database and share them
with others in your organization. When you use those
services, the ArcSDE server will do the work of matching
addresses to geographic locations.

Do not use the StreetMap USA geocoding service in the
Data & Maps for StreetMap CD-ROM. It can only be
used for client-side geocoding. You need to create a new
one in the ArcSDE server.

1. In ArcCatalog, create a database connection that
accesses the ArcSDE server that you will use for
geocoding.

Within the geodatabase you’ll see the server’s
Geocoding Services folder.

10

5B C=talog
EII:Q [ atabaze Connections
- ngl| Add OLE DB Connection

----- a3 Add Spatial D atabase Connection

Elg by ArcSDE connection. sde
EI@ Geocoding Services

----- B Create New Geocoding Service

2. Double-click Create New Geocoding Service in the
server’s Geocoding Services folder.

The Create New Geocoding Service dialog box appears.
3. Click SDE.StreetMap USA, then click OK.
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SDE.US Streets
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o]

Cancel

Help |
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The New SDE.StreetMap USA Geocoding Service
dialog box appears.

4. In the Name text box, replace the default name “New
Geocoding Service” with the name “StreetMap USA”.

5. Click OK.

The new geocoding service appears in the server’s
Geocoding Services folder. As with the geocoding
services created on your computer, ArcSDE geocoding
services will be prefaced by the username you used to
access the geodatabase.

9 Catalog
EIEQ Databaze Connections
83 Add OLE DB Connection

@ Add Spatial Databaze Connection
Elg My &rc5DE connection, sde
EI@ Geocoding Services

38 Create New Geocoding Service

----- @. Lzermame. Streethd ap LS4

Now you can repeat the task you completed in the first
exercise (geocoding the addresses in the addr us dBASE
table). This time, use the ArcSDE geocoding service.
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